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Organze.Leverage. Succeed. Tax-Deductible Contributions — How to Record the Tax-Deductible Amount
and How to Mass Update a List of Contributions with a Tax-Deductible Percentage

Author: Kristenson, Joel
Last Updated: 2016-11-22

Overview

This article will teach you how to enter the tax-deductible donation amount when recording/updating donations. It walks through a few different
methods such as:

- Recording it on a single donation record
- Setting the tax-deductible percentage for a list of donations en masse
- How to batch enter the data in a list (grid) view utilizing the editable column feature

Outline

#1 Enter the Tax-Deductible Donation Amount into a Single Donation Record
#2 Set a Tax-Deductible Percentage for a List of Donations En Masse
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#3 Batch Entering the Tax-Deductible Amount for Donations in the List (Grid) View using Editable Columns
#4 Related Resources

#1 Enter a Tax-Deductible Donation Amount into a Donation Record

Navigate to the Contacts (Voters/Donors) list.
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o5 Settings  Help

Application Menu €

E| = &

Tazks
B Dashboard
[» % Organization
» & Calendar/Tasks
[ @ Canvassing
4 % Contact
Contacts 1—
@j Addresses
@j Households
Contact Relationships
| ‘& Contributions/Pledges
5 7 Product Sales
[ @ Logs
i+ 7% Communications
> (B Finandial
[» % System Manager

Query for and open the donor’s record that contains the donation that you want to record a tax-deductible amount for. In my example | searched
for my own record.
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Search for and open the donor's record that has the donation in it you want to record a tax-deductible amount for.

<2 Search %, Reset |4 New ™| EH F & File ~ Edit ~ | &IncludeO‘ther Con‘taclsI
Q

Favorites | 4% General | Address [ Household | Attribute | Canvass | Relation | Contribute [ Pledge | Event [ Sales [Log [ Admin [ saL |

# Name | Phone | E-Mail | Email Links | Profile | Work | Demographics | User, Text | User, Dates | User, Decimal | Other |

Q
Individual Lost Nome 7“““'“0”7' Search zll name parts THe ]
Corporation First/Org Name: ~  [(amywhere in field) Suffiz: -
Foundstion Middle Name: -\ ]
Nickname:
Prior Last Name:

SEEdit 7 Sort EF Format ~ =3 Wrap Dﬁ Export &Print @ Summary D] B & Pivot |

Contacts [ 1 records found ]

Zip Home Employer/Company

= ] ) ] :
i) Title Last Name < First Mame I Street Street 2 City State Code Phone Bus Phone Cell Phone Email Mame

|u 12796 Senor Kristenson Joel Anders [ 9110 Golden Valley Rd Apt 10 Golden Valley MM 55427 [843) 442-1919 [866) 9095700 [654) 8979875 Jjkristenson@trailblz.com Trail Blazer

Click on the donor's name to open their record card.

Navigate to the Contribute tab and open the donation record you want to record a tax-deductible amount for. In my example | selected a 51,500
donation made on 4/6/2012.
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Title:

First Name
Middle Name
Last Name/Suffix
Prier Last Name

Mickname

Contact Type:

senar

Joel

Anders

Kristenson

senar Pepé

File - Edit - | 3 | @ <= | % 8 | Joel Anders Kristenson [12796]

Home Address
J1 10 olden Valley Hd
Apt 10

|

Beware of cats (street 3 merge field)
Golden Valley, MN 55427

AA7 4471919
il Work Add
jkristenson@trailblz com r ress
Mo Address

[Individual

™

—

I]Gmel’allHousd}dleaﬂaylktrbueanﬂ [ Rel

Contributions [125 records found]

&R New Refresh |} Sort [ Format ~ =3 Wrap

a'ml Contribute

Pledge | Evert | Logs | Sales | Admin |

port &Print ) Pivat |

Amount De- Applied Allocated Memaorial/ = .
Cpen Date After Cycle Event :‘ayment pos- Against Batehes to Specific  Honorarium MemornaUhonciaiue
ethod H Expected Person
Refunds ited Pledges Funds Type
Open 8/12,/2014 " 2,965.00 | Calendar Year 2014 2016 Celebrity Golf Tournament Credit Card 00 .00 00
Open 8/12/2014 " 265.00 | Calendar Year 2014 2016 Celebrity Golf Tournament Credit Card .00 00 .00
Open 7/30/2014 " 50.00 | Calendar Year 2014 Internal Event - Donations via Social M... | Credit Card .00 00 .00
Open 7/30/2014 " ©5,000.25 | Calendar Year 2014 Internal Event - Donations via Social M... | Credit Card .00 00 ©25,000.25
Open 7/28/2014 " 200,00 | Calendar Year 2014 Credit Card .00 00 .00
Open 6/6/2014 " 68.25 | Calendar Year 2014 Credit Card .00 00 .00
Cpen 5/23/2014 " 2,308.50 | Calendar Year 2014 Elazing Trails - The King's Trail - (5/15/2.., | Credit Card .00 00 .00
Open 5/19/2014 " 2,308.50 | Calendar Year 2014 Elazing Trails - The King's Trail - (5/15/2... | Credit Card .00 00 .00
Open 5/8/2014 " 100.00 | Calendar Year 2014 21t Annual Golf Tournament Credit Card 00 .00 00
Open 5/8/2014 || 160.00 | Calendar Year 2014 Credit Card .00 00 .00
Open 5/1/2014 " 1,000.00 | Calendar Year 2014 Check .00 00 1,000.00
Open 9/27/2013 " 20.00 | Calendar Year 2013 Cash 00 00 00
pen , alendar Year re ar | ! |

[o] 9/23/2013 " 250.50 | Calendar Year 2013 Credit Card 00 00 00
Open 9/1/2013 " 500.00 | Calendar Year 2013 Cash .00 00 .00
Cpen 8/23/2013 " 250,50 | Calendar Year 2013 Credit Card .00 00 .00
Open &/2/2013 || 250.50 | Calendar Year 2013 Credit Card .00 00 .00
Open 7/22/2013 " 250.50 | Calendar Year 2013 Credit Card 00 .00 00
Open 7/17/2013 || 50.00 | Calendar Year 2013 Credit Card .00 00 .00
Open 7/5/2013 " 250.50 | Calendar Year 2013 Credit Card .00 00 .00
Open 7/15/2013 " 100.00 | Calendar Year 2013 Check 00 00 00
Open 7/9/2013 " 250,50 | Calendar Year 2013 Credit Card 00 00 00
Open 7/2/2013 " 250.50 | Calendar Year 2013 Credit Card .00 00 .00
Open 5/6/2013 || 100.00 | Calendar Year 2013 Credit Card .00 00 .00
Open 1/17/2013 || 5,000.00 | Calendar Year 2013 Check .00 00 .00

Open 4/6/2012 " 1,500.00 | Calendar Year 2012 Check 00 .00 00

|
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Under the General tab you can fill in the ‘tax-deductible amount’, and then click [Save and Close]. My example is below where | entered the full
amount as tax-deductible.
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9 Contribution

File » Edit = | 3 | @

Joel Anders Knstenson : 1,500.00

5110 Golden Valley Rd —Dﬂ
Apt 10 i

Beware of cats (strest 3 merge field) ——
Golden Valley, MN, 5427 1,500.00

Hefund | Alocate I Match | Memory/Honor | Muotify I Cither | Gateway|

|5 K Aruna Run - Portland -

| Calendar Year 2012 - |

Date Received: 4/ 6/2012 E~

Type: [ Check L ]

Fecurrence: [ single - ]
Check Mumber M/A
Amount: 1,500.00 Tax Deduct Amt: | 1,500.00

Mema: \

1. Enter the tax-deductible amount.

2

b Save || g'Saveand Close | () Cancel ]
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The next section will show how to mass update a list of donations with a set tax-deductible percentage (either full, partial, or zero).

#2 Set a Tax-Deductible Percentage for a List of Donations En Masse

Navigate to the Contributions list.
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o-l  Settings  Help

Application Menu

Tazks
fs Dashboard
[ % Organization
» & Calendar/Tasks
[ % Canvassing
F % Contact
Contacts
@j Addresses
@ Households
Contact Relationships
4 B Contributions/Pledges
@ Contributions 4‘—
@ Contribution Allocations
@ Contribution Matches
@ Contribution Motifications
B Fledges
£ Pledges, Detail
[Z9 Thank You Letter - Contributions
i+ [ Reports
5 % Product Sales
[ @ Logs
i+ % Communications
[ a Financial
[ % System Manager
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Build and run your search query for the donations you want to update the tax-deductible amount for. In my example | populated all credit card
donations for 2016 which produced 76 results (as of the time this article was written, online donations will have a tax-deductible amount of zero).
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Build and run your search query for the donation records you want to mass update the
tax-deductible amount for. In this example it was all credit card donations for 2016.

<3 Search . Reset | 9k New = =2 File = Edit -« | Applyto Pledges | Contributions
"

|Favorit&a| General |Memor3,r."Honor|ﬁ DtherlGatmayICodadlSQL |

9

~ [-: custom, according to dates below> '] Products: [< ignore> v]
Date Range: |
1/ 1/2016 - <= [E- Recurrence: |< ignorex |Z||
Cycle: <ignore> E Deductibility: [< ignore=> v]
Event: <ignaorex |Z| Exclude Event: [< ignore: v]
Amount Range:  minimum w to  maximum - Alloc. Fund: |<ignore:» |Z||
Batch Code:

4 m b
=E Edit | Sort | Format - S3 Wrap BE Export & Print | Pivot

results |Cmtri1|lti|ms[?ﬁm:n|dsfnlnd]

= . Amount/ Tax Payment .

jin] * Date Last Name First Mame Amount Dedudible Method Street City State 3
456902 11/15/2016 | Allanson Willard 5.000.00 5.000,00 | Credit Card 2652 Paradise Trl NW Isanti MM
45901 4/1/2016 | Amundson Eugene 99.00 99,00 | Credit Card 7218 Robinwood Draw Woodbury MM
45900 10/10/2016 | Wynn Collette 65.00 65,00 | Credit Card 17453 Glacier Way Lakeville T
46599 11/14/2016 | Adelman Edward 959.00 959,00 | Credit Card 641 6th 5t Albany MM
46595 4/6/2016 | Walton Melody 99.00 99.00 | Credit Card 22146 Firelight Dr Park Rapids T
456897 8/11/2016 | Adelmann Robert 566.00 566.00 | Credit Card 11020 250th St E Webster MM
46896 8/16/2016 | Labree John 45.00 45.00 | Credit Card 5501 Village Dr Edina MM
45895 9/18/2016 | Akemann James 80.00 50,00 | Credit Card 1021 Westwood Dr Faribault MM
456594 2/4/2016 | Ibrahim Yahya 200.00 B00.00 | Credit Card 12129th 5t 5 Minneapolis MM
456893 11/18/2016 | Horton Billy Bob 500.00 00 | Credit Card 546 Lake StE Minneapolis MM
&7 ARGRT 112306 | Kristancnn lral A5 0N nn | Cradit Card 9110 Snldan Wallasy B Galden YWallay BAR
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Click File > Set Tax Deductible Amount.
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s Search Y. Reset | 45 New = = File | Edit - | ) | Applyto Pledges | Contributions

)

Apply Against Open Pledges

Favortes | General | Memary./Honar I A Other I Gateway | Contact I Create Mass Email...
@ Write Letter...

Set Thank You Sent...
Set Thank You Phone Call...

[{custom, according to dates below> 1
1/ 1/2016 + <= E

e Print...
Cycle: <ignaore= é

~ Date Range:

Print Preview...

e el

Event: <ignaores
Amount Range:  minimum » fo  maximum Update Cycle..
Batch Code: Update Event...
Update Payment Method...
Set Tax Deductible Amount | 2

Add Allocation Fund

Export...

4| ] r

=2 Edit @Sort @Format - 53 Wrap BE Export &Print @Pivot |

= ) Amount/ Tax Fayment ]
[ w Date Last Mame First Mame Amount Deductible Meathod Street City State 3
45902 11/18/2016 | Allanson Willard 5.000.00 500000 | Credit Card 2652 Paradise Trl MW Isanti MM
45901 47172016 | Amundson Eugene 99,00 99,00 | Credit Card 7218 Robinwood Draw Woodbury MM
46900 101072016 | Wynn Collette 65,00 65,00 | Credit Card 17453 Glacier Way Lakeville T
4563 11/14/2016 | Adelman Edward 959.00 9589.00 | Credit Card 641 ath 5t Albany MM
45598 4/6/2016 | Walton Kelody 99.00 99,00 | Credit Card 22145 Firelight Dr Park Rapids CT
48597 8/11/2016 | Adelmann Robert 566.00 566,00 | Credit Card 11020 250th 5t E Webster I
45596 8/16/2016 | Labree lohn 45,00 45,00 | Credit Card 5501 Village Dr Edina I
46595 9/15/2016 | Akemann James 80.00 50.00 | Credit Card 1021 Westwood Dr Faribault [
45594 2/4/2016 | Ibrahim Yahya 800,00 300,00 | Credit Card 12129th 5t 5 Minneapalis M
orton illy Bo : : re ar ake inneapolis
458593 11/18/2016 | Hort Billy Bob 500,00 00 | Credit Card 546 Lake St E Pi li I
] | asce= 117202016 | Kristanzan lnal 45 0n 0n | Cradit Card 9110 Galdsn Wallsy B | Goldan Walley | BAM L
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Click [OK] to proceed.

Warning

_ This function will set the Tax Deductible Amount for ALL records
$ displayed. Be sure you have displayed OMLY the records you want to
change OR you have unchecked the Incl{ude) box on selected records
you don't want changed.

The next dialog will let you set the parameters.

I Cancel

You now have 3 options for setting the Tax Deductible Amount:
- Full = Set Tax Deductible Amount = Amount
- Non - Set Tax Deductible Amount =0
- Partial — Set Tax Deductible Amount = % of Amount (then choose the percentage)

In this example | updated the amount to 100% for all donations in my list. Click [OK] to proceed after selecting your preference.

KNOWLEDGE BASE www.trailblz.com/kb 14



http://www.trailblz.com/kb

@ Z;Qﬁ‘ié!ﬂzer Tax-Deductible Contributions — How to Record the Tax-Deductible Amount
and How to Mass Update a List of Contributions with a Tax-Deductible Percentage

Set Tax Deductible Amount

i@ Full - Set Tax Deductible Amount = Amourt

1. Select your
preference.

™) Non - Set Tax Deductible Amourt = 0
() Partial - Set Tax Deductible Amount = % of Amourt
Set Percent: 100

After the process is finished you’ll get a notification with the results, click [OK] to finish.

You'll get a notification with the results after the process is complete.

S5

Setting of the tax deductible amount is complete, 76 records updated.

If you format in the Amount Tax/Deductible column into the grid you can verify the results. My finished example is below.
KNOWLEDGE BASE www.trailblz.com/kb 15



http://www.trailblz.com/kb
http://trailblz.com/kb/?action=view&kb=272&cat=1

& TrailBlazer

Organbe.Leverage. Suceeed. Tax-Deductible Contributions — How to Record the Tax-Deductible Amount
and How to Mass Update a List of Contributions with a Tax-Deductible Percentage

KNOWLEDGE BASE www.trailblz.com/kb 16



http://www.trailblz.com/kb

& TrailBlazer

Organtze Leverage. Succeed. Tax-Deductible Contributions — How to Record the Tax-Deductible Amount

and How to Mass Update a List of Contributions with a Tax-Deductible Percentage

~ Date Range: [< custom, according to dates belows> v] Preducts: [-: ignare> -
' 1/ 1/2016 - <= = Recurrence: |-c ignare= |z|
Cycle: <ignarex ﬂ Deductibility: [-:ignu-le:» - - .
Ewvent: <ignores |E| Exclude Event: [-eignure:» ,l You can format thIS COII.Imn lnt
Amount Range:  minimum * to maximum - Alloc. Fund: |<igr|cure> |z|| the grid tn verify the amou nts
Batch Code:

are correct after running your
mass update.

|

1

=& Edi - S5 & i i
,:,E Edit @Sort @Format =3 Wrap gExport &Prmt @Plvot |
Contributions [ 76 records found ]

ID v Date Last Name First Name Amount g’:é’ﬁ;it‘; lT:“ :f:&i’:jt Street City State
Allanson Willard | 5,000.00 5,000.00 |_| redit Card

46901 4/1/2016 | Amundson Eugene 99,00 99,00 | Aredit Card 7218 Robinwood Draw Woodbury MM
45900 10/10/2016 | Wynn Collette 65.00 65.00 | gredit Card 17453 Glacier Way Lakeville T
46599 11/14/2016 | Adelman Edward 989.00 959.00 | gredit Card 641 6th 5t Albany MM
46898 4/6/2016 | Walton Melody 99.00 99.00 | gredit Card 22146 Firelight Dr Park Rapids cT
46897 §/11,/2016 | Adelmann Robert 566.00 566.00 | gredit Card 11020 250th St E Webster MM
46896 5/16/2016 | Labree lohn 45.00 45,00 | gredit Card 5501 Village Dr Edina MM
45895 9/18/2016 | Akemann James 80.00 30.00 | Wredit Card 1021 Westwood Dr Faribault MM
40894 2/4/2016 | Ibrahim Yahya 300,00 300,00 | gredit Card 121258th 5t S Minneapolis MM
46893 11/18/2016 | Horton Billy Bob 500.00 500.00 | gredit Card 546 Lake St E Minneapalis MM
2] | agssg= 11249016 | Krictensnn Inel LA A5 00 | @radit Card 911 fGnldsn Walley Bd Golden Valley | BN i

=] | 76 | | | | | 6,246,279.15 | 6,246,279.15 | | |

4 L
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If a mistake was made you can usually roll-it-back if you catch it in time.

The next section will show how to modify the tax-deductible amount in the ‘grid/list’ view by adding in the necessary columns and making them
‘updatable’.

#3 Batch Entering the Tax-Deductible Amount for Donations in the List (Grid) View
using Editable Columns

Navigate to the Contributions list under the Application Menu.
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E) Seitings Help
Application Menu <

fs Dashboard
[» % Organization
' Calendar/Tasks
[ % Canwvassing
F % Contact
Contacts
@j Addresses
@ Households
Contact Relationships
4 "By Contributions/Pledges
@ Contributions <
@ Contribution Allocations
@ Contribution Matches
% Contribution Motifications
EJ Pledges
[tJ Pledges, Detail
[ Thank You Letter - Contributions
> [ Reports
& (7 Product Sales
[ Qf} Logs
i+ 7% Communications
[» ﬂ Financial
i g System Manager
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Build and run your search query. In this example | populated all credit card contribution records for 2015 which produced 656 donation records.
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.. Reset | b New oo B

File - Edit ~ | 0  ApplytoPledges | Contributions |

| Favortes | # Generwl | Memory/Honor | /* Other | Gateway | Cortact [ SQL |
Q

~ Payment Metheds: | Credit Card = | Thank You Letter:

Use Type Thank You Call <ignores . .
Vemo [ =—— <=~ Build and run you search query for the donation records

Check Mumber: In-Kind Type: <ignore= - ~ .
o o e you want to update the tax-deductible amount for.

In this example it was all donations in 2015 that were
made by credit card.

EE Edit @Sort @Format - =3 Wrap BB Export &Prmt @ Pivot |
‘Contributions [ 656 records found ]

Contact  Last First Appliza 00 Toa© Thank Thank o z Deposit  Cycl Payment R
o) Date IE;’" a Na:m . N':,n . ML Amount Against [P:r ges Deposited Lz;e’ You  YouCall " Street Street 2 City State C'o"d " D:f:“ Ig‘ £ Cyde N:’mz’; T;;‘:
Pledges Sent Date Done
28 Calendar Year 2015 { Credi
46455 11/23/2015 | 14379 Waaner Anthony 15.00 00 00 10101 Fondren Rd Suite 222 Houston ™ 77096 28 Calendar Year 2015 Credit Card
46433 11/20/2015 | 14373 Canyl Alysia 145.00 .00 00 390 Ashton Ave San Francisco cA 94112 2B Calendar Year 2015 Credit Card
46432 11,/20/2015 | 14777 Unknown Abigail 17543 .00 00 123 Main St Eugene OR 123456 28 Calendar Year 2015 Credit Card
46450 11/18/2015 | 14775 Wheelock Alex 1,000.00 .00 00 1705 Highway 59 Suite 11 Mandeville LA T0443 28 Calendar Year 2015 Credit Card
46479 11/12/2015 | 14774 Ferguson Ashley 147.55 .00 00 1701 Shackleford Rd S Little Rock AR 72211 23 Calendar Year 2015 Credit Card
46475 11/2/2015 | 14773 LCaplan Heil 145.00 00 00 PO Box 843 Glenham MY 12577 28 Calendar Year 2015 Credit Card
48477 11/12/2015 | 14772 Melson Amber 123.56 00 00 PO Box 85 Oakley ur 84055 28 Calendar Year 2015 Credit Card
46475 11/11/2015 | 14770 Crum Caitlyn 145.00 .00 00 425 Sugar Maple Ln Marion OH 43302 28 Calendar Year 2015 Credit Card
46473 11/10/2015 | 14763 Ozorkiewicz Melodie 145.00 .00 00 PO Box 101104 Fort Worth ™ JB185 i Calendar Year 2015 Credit Card
46472 11/9/2015 | 14767 McMahon Cory 145.00 .00 00 2151 59th 5t St Louis MO 63110 28 Calendar Year 2015 Credit Card
46471 11/5/2015 | 14766 Jentgen Julie 2457 .00 00 158 Sleep Bowl Rd Chandler AL 85286 ) Calendar Year 2015 Credit Card
45469 11/4/2015 | 14785 Piatt Evin 1,000.00 .00 00 1258 Landmark Trl 5 Hopkins MM 55343 28 Calendar Year 2015 Credit Card
46465 11/4/2015 | 14764 Gray Damian 145.00 00 00 5330 Technolagy Ln Birmingham AL 35210 75 Calendar Year 2015 || Credit Card
o467 11/4/2015 | 14763 Eroughton Catherine 145.00 00 00 2510 Mills Branch Dr Apt 140 Humble ™ FI345 28 Calendar Year 2015 Credit Card
46466 11/4/2015 | 14762 Miller Derek 145.00 .00 00 3050 K St NW Suite 350 Washington DC 20007 28 Calendar Year 2015 Credit Card
46465 11/4/2015 | 14762 Miller Derek 145.00 .00 00 3050 K St NW Suite 350 Washington DC 20007 28 Calendar Year 2015 Credit Card
46462 11/3/2015 | 14761 Rice Donald 145.00 .00 00 349 Plato Pl Middletown DE 19709 28 Calendar Year 2015 Credit Card
46447 11/2/2015 | 14760 Buzard Ron 145.00 .00 00 2500 Valleyhigh Rochester MM 55901 i) Calendar Year 2015 Credit Card
45445 11/2/2015 | 14759 Barstad Caitlyn 145.00 .00 00 56 Nor-nan Rd Winchester ™ 37398 28 Calendar Year 2015 Credit Card
1 | 46384 10/28/2015 | 147558 Lizhva Anastasiv 145.00 00 falil 71} sl 2016 Anniston Bd lacksanville OR 32744 28 Calendar Year 2015 Credit Card
E 656 147,370... .00 5,000.00 ] 656 0 18368
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Click the [Format] drop-down and select Columns.

KNOWLEDGE BASE www.trailblz.com/kb 22



http://www.trailblz.com/kb

& TrailBlazer

Organtze Leverage. Succeed. Tax-Deductible Contributions — How to Record the Tax-Deductible Amount

and How to Mass Update a List of Contributions with a Tax-Deductible Percentage

<3»Search W, Reset | dk New = =D File » Edit - |« | Applyto Pledges | Contributions

@ I
| Favorites | /F General | Memory/Honor | / Other | Gateway | Contact | SQL |
@ I
~ Payment Methods: Thank You Letter:
Usze Type: Thank You Call:
Memo:  Ezrmarked:
Check Number. In-Kind Type:
Anonymous: Bundler:

1

EE Edit @Sort @Format - |53 Wrap EE Export &Print @Pivot |

Contributions [ 656 JAK
‘@ Columns.. Z_—I First App_lied Esgges . Izznk LrEms ) L Check
8] E Select saved... Name Amount Against Per Deposited | 4 ‘E}c;;e ‘E‘}ooun Eall b= Street
Save Add or remove columns, apply formatting, or specify column attributes, | Sent
IT 46487 | Jazz | 175.00 00| 500000 | lili 1800 Baptist World Ce...
46485 of Sevehs.. Anthony 15.00 .00 .00 10101 Fondren Rd
45483 | Assign as default. Alysia 145,00 .00 .00 390 Ashton Ave
46487 | 11/20/2015 | 14777 | Unknown Abigail 175.43 .00 .00 123 Main 5t
46480 11/18/2015 | 14775 | Wheelock Alex 1,000.00 .00 00 1705 Highway 59
46479 11/12/2015 | 14774 Ferquson Ashley 147.55 .00 .00 1701 Shackleford Rd 5
46478 | 11/12/2015 | 14773 | Caplan Meil 145,00 .00 .00 PO Box 843
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Check the box on the right for ‘Amount/TaxDeductible’. This is the step that will add that column into the list (grid).
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) Column Selection

Columns | Farmat

Table Columns [Contribution]

% AccountFecTypeld
LllocationCount
AllocationFund
Amount
AmountTaxDeductible
AmountifterRefunds
AmountAllocatedToFunds
_ AmountippliedAgainstPledges
Joined Tables AmountUnallocated
'Q, 4 [ Contribution . EE’D“
P itCount
4 B Contact _ H AuditFirstDate
(57 Address [DefaultDisplay] AuditLastDate
@ Address [Home] BatchCode
(5 Address [Maiiing] Bill ToAddressID
FEF} Address [Registration] Browserlnformation
. Address [Work] CandidateXld

@ oc ] @ ]
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Navigate to the Format tab and scroll to the bottom of the list.
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H
&) Column Selecﬁnnu gni
cotomn]) Foma | 1
Format
ey
—a
—s
-
. ’ - . Woard
Column Heading Filker  Wisible Width Wrap Frozen Updatable  Typ
CheckNumber Check# 49 Text
Address [Mailing].Address [Mailing].5treet Street 137 Text
Address [Mailing].Address [Mailing].Street2 Street 2 71 Text
Address [Mailing]. Address [Mailing].City City a5 Text
Address [Mailing].Address [Mailing].5tate State 43 Text
Address [Mailing].Address [Mailing].Zip Code Zip Code 52 Text
DepositDate Deposit Date 5 Date 2. Scroll to the bottom
Depositld Deposit Id 3 Inte: . -
Electionld Cycle ID 43 Inte: Of thls ||St so that the
Election .ElectionName Cydle 115 Text 'Amountnaxneductible'
Mon-Monetary Type.Description Mon Monetary Type 3 Text - - -
Payment Method.Description Payment Method 35 Text |5 optlon IS dlsplayEd'
Recurrence Type.DescriptionDefault Recurrence Type 86 Text
MemaorialTypelD Memaorial Type 3 Inte
BatchCode Batch Code 100 Text
Contact. ContributorTypeld ContributorTypelD 43 Inte
» IAmc:unt,.-"l'a:i:DeductitlIe Amount/ Tax Deductible 60 i
4 (L} »
Progress
]
[@ ok | [@cancel |
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Scroll to the right until you see the column called Updatable. Check this this box for the Amount/TaxDeductible row and click [OK].
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r
3) Column Selectiunu

Fomt

Column

Heading

CheckMumber

Check #

Text

Address [Mailing].Address [Mailing].5treet

Street

Text

Address [Mailing].Address [Mailing].5treet2

Street 2

Text

Address [Mailing].Address [Mailing]. City

City

Text

Address [Mailing].Address [Mailing].5tate

State

Text

Address [Mailing].Address [Mailing].Zip Code

Zip Code

Text

DepositDate

Deposit Date

DateTime

Depositld

Deposit Id

Integer

ElectionId

Cycle ID

Integer

Election .ElectionMame

Cycle

Text

Mon-Monetary Type.Description

Mon Monetary Type

Text

Payment Method.Description

Payment Method

Text

Recurrence Type.DescriptionDefault

Recurrence Type

Text

MemaorialTypelD

Memorial Type

Integer

BatchCode

Batch Code

Text

Contact.ContributorTypeld

ContributorTypelD

[ 3 I Amount/TaxDeductible Amount/ Tax Deductible
4

5

1 o 0 =
0

=

E
E
<]

Integer
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Scroll out to the far right of the grid where the new tax-deductible amount column will display.
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=g» Search ., Reset | 9F New il ) File = Edit ~ | &) | Apply to Pledges Contrihulionsl

|Fa\rort&s|);GerﬂdlMemornyomrliOthﬁlﬁaewaleortadlmL |

Payment Methods: Thank You Letter: [ <ignore>
Use Type: Thank You Call: <ignares

Memo: Earmarked: <ignaores
Check Number: In-Kind Type: <ignore>

Anonymaous: <ignore= « | Bundler: <ignore>

< |
8 Edit @Sort @Format - 53 Wrap DE Export &Print @Pivot |
Contributions [ 656 records found ]

et R gincose  Contf o
46487 / ? 14780 Daigle Jazz IEEI? 28 Calendar Year 2015 I Credit Card 20151124 from-... ll— |
46485 11/23/2015 | 14779 Wagner Anthony 096 28 Calendar Year 2015 Credit Card 20151124 from-.. |1 00
46483 11/20/2015 | 14778 Canyl Alysia 112 28 Calendar Year 2015 || Credit Card 20151124 from-.. |1 00
46432 11/20/2015 | 14777 Unknown Abigail 3456 28 Calendar Year 2015 Credit Card 20151124 from-... (1 .00
46450 11/18/2015 | 14775 Wheelock Alex 443 28 Calendar Year 2015 Credit Card 20151124 from-.. |1 00
46479 11/12/2015 | 14774 Ferguson Ashley 211 28 Calendar Year 2015 Credit Card 20151124 from-.. |1 00
46478 11/12/2015 | 14773 Caplan Meil 527 28 Calendar Year 2015 || Credit Card 20151124 from-... |1 00
46477 11/12/2015 | 14772 Helson Amber Q55 28 Calendar Year 2015 Credit Card 20151124 from-.. |1 00
46473 11/11/2015 | 14770 Crum Caitlyn 302 28 Calendar Year 2015 || Credit Card 20151124 from-.. |1 00
46473 11A40/2015 | 14765 Ozorkiewicz Melodie 135 28 Calendar Year 2015 Credit Card 20151124 from-... (1 .00
46472 11/9/2015 | 14767 MchMahon Cory 110 28 Calendar Year 2015 Credit Card 20151124 from-.. |1 00
[ | 46471 11/5/2015 | 14766 lentnen lulie ri 28 Calendar Year 2015 Credit Card 20151124 from. 1 on 1™
Bless| | | | [ | 1836 | | | | L -WH
1 | m | 13
Llogon=  Joel Kristenson / |L—_| Save | |»ﬁ Save and Close | l& Reports ] ’# New ] [@ Close ]
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Click-and-hold on the column title and drag it to the left until it’s next to the Amount column, then release it to complete the move. In my
example | also removed columns | wasn’t interested in via formatting.
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<3 Search %, Reset | <k New =0 =l File = Edit - | 0 | Applyto Pledges | Contributions
5]

|FaM&B|fGaﬂd|Mameonor|jyotth|Eamay|Cortad|5QL |

Fayment Methods: Thank You Letter:
Thank You Call:
Earmarked:
In-Kind Type:

Bundler:

Credit Card b <ignore=

se Type: <ignaores <ignares

Memo:

Check Number:

<ignore=
<ignore=
<ignores

Anonymous: <ignorex

Click and drag this column to the left
so it's next to the ‘Amount’ column.

<
=& Edi - S5 L i i

] EE Edit @Sort @Format =3 Wrap EExport &Prlnt @Pwot |

Contributions [ 656 records found ]

ez i

11/23/2015 1800 Ba c Mashville ™ 37207 Credit Card _| L1y
11,/23/2015 | Wagner Anthony 15,00 | 10101 Fondren Rd Suite 222 Houston ™ 77096 Credit Card 00
1172072015 | Caryl Alysia 145.00 | 390 Ashton Ave 5an Francisco CA 94112 Credit Card 00
1172072015 | Unknown Abigail 17543 | 123 Main 5t Eugene OR 123456 | Credit Card 00
11A8/2015 | Wheelock Alex 1,000.00 | 1705 Highway 59 Suite 11 Mandeville LA 704438 Credit Card 00
11442/2015 | Ferguson Ashley 147.55 | 1701 Shackleford Rd § Little Rock AR 7211 Credit Card 00
111272015 | Caplan Meil 145,00 | PO Box 843 Glenham MY 12527 Credit Card 00
11/12/2015 | Melson Amber 123.56 | PO Box 85 Oakley uT 84055 | Credit Card .00
1111/2015 | Crum Caithyn 145.00 | 425 Sugar Maple Ln Marion OH 43302 Credit Card 00
11072015 | Ozorkiewicz | Melodie 145,00 | PO Box 101104 Fort Worth T 76185 Credit Card 00
11/9/2015 | McMahon Cory 145.00 | 2151 59th 5t 5t Lowis MO 63110 Credit Card 00
1 [l 44 /E A E | Jantman Ilie A4 E7 | 152 Claarm Frawd] B “handlar AT RCARE mradit mard N
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After you’ve placed the tax-deductible column next to the amount column, click the [Edit] button so the new column turns green. Any cell in green
in Trail Blazer allows you to edit it in the grid view, which can save a lot of time instead of going record by record.
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<3 Search M. Reset | b New =i = File » Edit - | /| Applyto Pledges | Contributions
Q|

|Favo;i&a|)7GmadlManwamml)’OtthlﬁaewalemtadlmL |

9

‘ Payment Methods: Thank You Letter: | <ignore=
Use Type: Thank YouCall. | <ignore>

Meme: Earmarked: <ignore=

Check Number: In-Kind Type: <ignore=

Anonymous: <ignores w | Bundler: <ignores

—

) Sort ) Format = =3 Wrap Bﬁ Export &aprint ) Pivot |

!

Date ha;;] . E'a“"t] . Amount ‘3’:;5;:“; lT:“ Street Street 2 City State Eigd . Ef:'mj’:jt TR;;:"E”“

o - ) d Ce : 2 d
11/23/2015 | Wagner Anthony 15.00 .00 | 10101 Fondren Rd Suite 222 Houston ™ 77096 Credit Card
11/20/2015 | Caryl Alysia 145.00 00 | 390 Ashton Ave San Francisco CA 94112 Credit Card
11/20/2015 | Unknown Abigail 17543 A0 | 123 Main 5t Eugene OR 123456 | Credit Card
11/18/2015 | Wheelock Alex 1,000.00 .00 | 1705 Highway 59 Suite 11 Mandeville L& T0445 Credit Card
11/12/2015 | Ferguson Ashley 147,55 A0 1701 Shackleford Rd 5 Little Rock AR 72211 Credit Card
11/12/2015 | Caplan Meil 145.00 00 | PO Box 843 Glenham MY 12527 Credit Card
11/12/2015 | Nelson Amber 123,56 M0 | PO Box 85 Cakley ur 34055 Credit Card
11112015 | Crum Caitlyn 145.00 00 | 425 Sugar Maple Ln Marion OH 43302 Credit Card
11/10/2015 | Ozorkiewicz | Melodie 145.00 00 | PO Box101104 Fort Warth ™ 76185 Credit Card
11/9/2015 | Mciahon Cory 145.00 00 | 2151 59th 5t 5t Lowis MO 63110 Credit Card
11/5/2015 | Jentgen Julie 24.5 M0 | 158 Sleep Bowl Rd Chandler A7 85286 Credit Card

Y i
4 | 658 147,370.27 00
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You can now double-click in the green cell and populate the data for the tax-deductible amount. Click [Save] in the bottom-right as you go. My
finished example is below.
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< Search Y. Reset | & New oM E oS File - Edit - | &) | Applyto Pledges | Contributions

o

|Fa\rorit&s|}7 Gerﬂalll't‘remoryfl-kxm| A Other |Gateway|Codad|SQL |

o

~ Fayment Metheds: | Credit Card | Thank You Letter: | <jgnares
Use Type: Thank You Call: <ignore>

Mema: Earmarked: <ignore>

Check Mumber: In-Kind Type: <ignare=

f— awder [ sianore

4 m N

@Sor’c @Format - 53 Wrap @E Export &Print @Pivot

Contributions [ 656 records found ]

Date ha;; . E’;ﬁ . Amount ‘S’:é’j&f‘; lT:" treet Street 2 City State Ei‘fd . :fg&fj’:f ?;;:"e"“ B
11/23/2015 | Daigle Jazz 1?5.00' 45.00 FUU Baptist Waorld Ce... Mashville TN 37207 Cradit Card
11/23/2015 | Wagner Anthony 15.00' 15.00 :lllnl Fondren Rd Suite 222 Houston T 77096 Credit Card
11/20/2015 | Caryl Alysia 145.00' 100.00 | 390 Ashton Ave San Francisco CA 94112 Credit Card
11/20/2015 | Unknown Abigail 1?5.43' 100.00 | 323 Main St Eugene OR 123456 | Credit Card
11/18/2015 | Wheelock Alex 1_000.00' .00 | ¥705 Highway 59 Suite 11 Mandeville LA 70445 Credit Card
11/12/2015 | Ferguson Ashley 14?.55' 147.55 | §701 Shackleford Rd 5 Little Rock AR 72211 Credit Card
11/12/2015 | Caplan HMeil 145.00' 145.00 | §BO Box 543 Glenham MY 12527 Credit Card
11/12/2015 | Nelson Amber 123.56' 123,56 WO Box &5 Oakley ur 54055 Credit Card
11/41/2015 | Crum Caitlyn 145.00' .00 | 425 Sugar Maple Ln Marion OH 43302 Cradit Card
11/10/2015 | Ozorkiewicz Melodie 145.00' 00 B0 Box 101104 Fort Worth T 76185 Credit Card
11/9/2015 | McMahon Cory 145.00' 145,00 J151 59th 5t St Louis MO 63110 Credit Card
11/5/2015 | lentgen Julie 24.57 .00 | ¥55 Sleep Bowl Rd Chandler AL 85286 Credit Card
11/4/2015 | Piatt Kevin 1,000 1,000.00 | 3256 Landmark Trl 5 Hopkins MM 55343 Credit Card
11/4/2015 | Gray Damian ﬁ.ool 25.00 | §330 Technology Ln Eirmingham AL 35210 Credit Card
11/4/2015 | Broughton Catherine /145.00' 25.00  #510 Mills Branch Dr Apt140 Humble T 77345 Credit Card
[¥] 11/4/2015 | Miller Derek _4, 145,00 25.00 | 3050 K 5t NW Suite 350 Washington DC 20007 Credit Card ™

3 | 636 | 147,370.27, 2,116.11|| | | | | | |
< m | »

Logon=  Joel Kristenson 2 |[H Save ]PSave and Close ] ’& Reports ] [% Mew ] ’@ Clese ]
7

1 Doubhla-cliclk in the Aarean ralle
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The related resources below link to a variety of useful article and videos on this topic.

0009

Trail Blazer

- YouTube Channel
- Knowledge Base Articles
- 3rd Party Resources

KNOWLEDGE BASE www.trailblz.com/kb
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Related Resources

Article: Contribution Year-End Report

Article: Enter Contributions

Article: How to Change your Current, Previous, and Next Cycle or Fiscal Year, and How to Mass Update Donations to a Specific Cycle or Fiscal Year

En Masse — Nonprofit Only

Article: How to Add and Remove the Allocation Funds to your Online Donation Form, and to the Drop-Down Menus in your Database

Article: How to Remove an ‘Event’ from the Drop-Down List when Entering Donations

Article: Contribution Year-End Report

Article: How to Create a Custom Redirect Thank-You Page for your Donation Form(s) that Automatically Populates the Donor’s First Name and the

Donation Amount they Gave — Advanced Feature

Article: Memorial and Honorarium Gifts — Add the Option to your Online Donation Form, and How to Run Searches and Build Reports on these
Type of Gifts in the Database
Article: Custom Donation Amounts for Non-Primary Pages — List of All Configurable Donation Page URL Options

Article: Recording Non-Monetary (In-Kind) Contributions and Creating New Non-Monetary Types

Article: Delete a Contribution

Article: How to Enable ACH (E-Check) Payments with the Vanco Merchant Gateway on Trail Blazer’s Donation Form

Article: Modify your Donation Form — Change the Amounts — Add Descriptions — Add & Remove which Amounts Display

Article: How to Put your Trail Blazer Donation Form on your Facebook Page

Article: How to Add the Security Disclaimer Section to your Online Donation Form, and How to Style the Text Inside with htm| & CSS

Article: How to Create a Custom Thank-You Auto-Responder Email with Merge Fields for your Online Donation Form

Article: How to Configure Recurring Donation Options for your Trail Blazer Donation Form (must be using either Vanco Services or Authorize.Net as

your Merchant Gateway)
Video: Getting Started 106a — Entering Contributions (NON PROFIT ONLY)
Video: Thank you’s using mass email

Video: Thank A Person Once For Multiple Contributions
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http://trailblz.com/kb/?action=view&kb=312&cat=1
http://trailblz.com/kb/?action=view&kb=323&cat=1
http://trailblz.com/kb/?action=view&kb=352&cat=1
http://trailblz.com/kb/?action=view&kb=184&cat=1
http://trailblz.com/kb/?action=view&kb=134&cat=1
http://trailblz.com/kb/?action=view&kb=134&cat=1
http://trailblz.com/kb/?action=view&kb=349&cat=1
http://trailblz.com/kb/?action=view&kb=349&cat=1
http://trailblz.com/kb/?action=view&kb=155&cat=1
http://trailblz.com/kb/?action=view&kb=296&cat=1
http://trailblz.com/kb/?action=view&kb=31&cat=1
http://trailblz.com/kb/?action=view&kb=293&cat=1
http://trailblz.com/kb/?action=view&kb=338&cat=1
http://trailblz.com/kb/?action=view&kb=259&cat=1
http://trailblz.com/kb/?action=view&kb=324&cat=1
http://trailblz.com/kb/?action=view&kb=329&cat=1
http://trailblz.com/kb/?action=view&kb=319&cat=1
http://trailblz.com/kb/?action=view&kb=319&cat=1
https://www.youtube.com/watch?v=Ist5zzEKkoU
https://www.youtube.com/watch?v=6KZq8LCXsZI
https://www.youtube.com/watch?v=beuemt0SOD4
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Video: Getting Started 107 — Writing Contribution Thank You Letters
Video: Year End Tax Letter

Video: Write Letter — Edit Letter after Mail Merge

Video: Filtered Contribution Columns in Format

Video: Donation Auto Responders with Merge Fields
Video: Attributes — Add To Donation Page
Video: Iframes

Video: Contributions Online — Change Default $ Donation Amounts

Trail Blazer Live Support

© Phone: 1-866-909-8700

® Email: support@trailblz.com

El Facebook: https://www.facebook.com/pages/Trail-Blazer-Software/64872951180
K1 Twitter: https://twitter.com/trailblazersoft

* As a policy we require that you have taken our intro training class before calling or emailing our live support team.

Click here to view our calendar for upcoming classes and events. Feel free to sign up other members on your team for the same training.
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mailto:support@trailblz.com
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* After registering you’ll receive a confirmation email with the instructions for how to log into the GoToMeeting session where we host our live
interactive trainings.

* This service is included in your contract.
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